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How to get Help
This section explains how to get help for Nortel products and services.

Getting Help from the Nortel Web site
The best way to get technical support for Nortel products is from the Nortel Technical 
Support Web site:

http://www.nortel.com/support

This site provides quick access to software, documentation, bulletins, and tools to 
address issues with Nortel products. More specifically, the site enables you to:

download software, documentation, and product bulletins

search the Technical Support Web site and the Nortel Knowledge Base for 
answers to technical issues

sign up for automatic notification of new software and documentation for Nortel 
equipment

open and manage technical support cases

Getting Help over the phone from a Nortel Solutions Center
If you don’t find the information you require on the Nortel Technical Support Web site, 
and have a Nortel support contract, you can also get help over the phone from a Nortel 
Solutions Center. 

In North America, call 1-800-4NORTEL (1-800-466-7865).

Outside North America, go to the following Web site to obtain the phone number for 
your region:

http://www.nortel.com/callus

Getting Help from a specialist by using an Express Routing Code 
To access some Nortel Technical Solutions Centers, you can use an Express Routing 
Code (ERC) to quickly route your call to a specialist in your Nortel product or service. To 
locate the ERC for your product or service, go to:

http://www.nortel.com/erc

Getting Help through a Nortel distributor or reseller 
If you purchased a service contract for your Nortel product from a distributor or 
authorized reseller, contact the technical support staff for that distributor or reseller.

http://www.nortel.com/support
http://www.nortel.com/callus
http://www.nortel.com/erc
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Welcome to My CallPilot

My CallPilot* from Nortel is a web-based business communications 
system that offers exceptional flexibility for managing your messaging 
needs. 

You can work with My CallPilot from any computer that has Internet 
access and a web browser configured for My CallPilot. Here are some of 
the many ways you can use My CallPilot:

Enable record, edit, and delete greetings.
Configure the Message Forwarding Rule.
Configure e-mail-by-phone.
Configure mailbox link.
View useful information about your mailbox.
Receive, forward, reply to, and send voice messages, faxes, 
and e-mails.
Change the setup of your mailbox features. 
Change your CallPilot password.
Create personal distribution lists.
Set up remote notification to a telephone or pager.
Set up text message notification for a wireless e-mail device. 
See Appendix A for details.

Some features mentioned in this guide are options. For details, refer to the 
Feature availability topic in the CallPilot Player online Help, or ask your 
administrator. 

NOTE: The screen images of dialog boxes shown in this guide are those 
displayed when operating My CallPilot in the Windows environment, 
unless otherwise specified. Users of the Macintosh or Linux environments 
may see altered versions of these dialog boxes, depending on specific 
feature and functionality support. 
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Getting started

About this guide
This user guide describes how to use the web-based resources of My CallPilot. The 
instructions and screen images shown in this guide provide general information for 
using My CallPilot through a web client. Specific details can vary, depending on your 
computer operating system and the features available for your CallPilot mailbox. 

For further assistance, refer to the My CallPilot online Help.

What you need
You can access My CallPilot from any computer with Internet access and a web 
browser configured for My CallPilot. Before you start to use My CallPilot, ensure that the 
computer you are using is set up according to the following requirements:

Windows-based hardware and software
Windows 2000 Professional, or Windows XP Professional

Windows Server 2003 Standard with IIS 6.0 

Internet Explorer 6.0; Netscape 6.2, 7.0, 7.1, 7.2; or Mozilla 1.7.x and Mozilla 
FireFox 1.0 on RedHat Linux 9 Operating System 

Sound card and speakers for playing voice messages on your computer
A microphone connected to your computer, or a telephone situated near your 
computer, for recording voice messages

Macintosh-based hardware and software
PowerPC G3 processor or newer (PowerPC G4 preferred)

Mac OS X, 9.0 or 9.1(preferred)

RedHat Linux 9 Operating System
Note: The Mac My CallPilot Web Client software is not designed for compatibility with 
Mac OS X. Although this version of the CallPilot application can run in OS 9.0 and 9.1 
Compatibility mode, the CallPilot application may crash or behave erratically.

Internet Explorer 5.1

QuickTime version 4.0 
AppleScript version 1.3 

TCP/IP network connection of at least 56 Kbit/s

MacOS-supported sound output device (speakers)
MacOS-supported sound input device (microphones)

Note: The type of microphone to use depends on the type of Macintosh the user has, 
and a microphone designed for a Windows-based PC often does not work. Some older 
PowerPC Macs require a PlainTalk microphone, or similar. The system administrator 
should verify that the user has a working microphone and speaker setup before 
installing My CallPilot.

Linux-based software
Red Hat Linux 9
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Mozilla 1.7x browser

Audacity 1.2.x, Gnome Sound recorder 2.x, and Krecord 1.1 audio applications
Peripheral hardware and software

Video display and monitor with 8-bit (256-color) 800 x 600 capability (1024 x 768 
16-bit color preferred)

Nortel Fax Driver and CallPilot Desktop Messaging to create faxes
CallPilot Player to play and record voice messages. An embedded version of the 
CallPilot Player (shown in this guide) may appear in your inbox and voice 
messages. (For required settings, see Setting messaging preferences, on page 
57.) Some Windows-based systems and all Macintosh systems do not display the 
embedded player. If not, you are be prompted to download the CallPilot Player. If 
you are on a Windows-based platform and are only playing messages, not 
recording, you can use the Microsoft Windows Media Player, or another WAV-
compatible media player. These players do not function in exactly the same way 
as the CallPilot Player described in this guide. 

LAN (Ethernet), ISDN, ADSL, or dial-up modem connection to the CallPilot 
server for accessing CallPilot messages

To download audio players
You need an audio player to play and record voice messages. The first time you log in 
to My CallPilot, My CallPilot checks to see that an audio player is installed. If one is not 
installed, you are prompted to download the CallPilot Player. Follow the instructions to 
start the download and installation process. If you need to re-install a player at a later 
time:

1 Click Downloads on the CallPilot Features main page. 

Select the CallPilot Player or other audio player from the list. The various 
downloadable players are shown below.
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                The Windows downloadable CallPilot Player

The Macintosh downloadable CallPilot Player with QuickTime 4.0

The Macintosh downloadable CallPilot Player with QuickTime 5.0

For the Linux environment, the following record and playback applications are 
supported:

Audacity 1.2.x

Gnome Sound Recorder 2.x
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Krecord 1.1

Other audio applications may work but are not supported.
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Logging in

Your administrator provides you with the URL for My CallPilot. Bookmark this address 
in your web browser for easy access.

To log in to My CallPilot
1 In your web browser, navigate to the My CallPilot address.

2 On the Welcome page, in Mailbox, type your mailbox number. This is usually 
your office telephone extension number.

3 In Password, type your CallPilot password.

4 Click Login.

To change to another server
If you have a mailbox on another CallPilot server, you can log in to that server from My 
CallPilot. Click Configure, type the server details, then click OK. When you log in again 
from the same computer, CallPilot accesses the new server. To change back to your 
default server, click Configure, then click Restore Default.

To change to another language
If language buttons are available on your My CallPilot log in page, you can click one to 
change from your default language to another language.

To log in using secure login
If the Enable Secure Login link is available on your login page, click the Enable Secure 
Login to enable SSL encryption. The Login Securely button appears. Bookmark the 
link for future log in.

To log in remotely
You can log in to My CallPilot from any computer that has Internet access and 
supported browser configuration. You can use the pre-installed audio player for voice 
messages, or you can download the CallPilot Player for full feature capability.

Do not check the 
Remember 
Password box on a 
shared computer.

The Login Securely 
link appears if SSL 
encryption is 
enabled.

Note:
Users of Windows
Server 2003 with
IIS 6.0 can use
Windows 2003 as
a client to log in
and use My CallPilot.
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To log out
To log out from My CallPilot, click Logout on any My CallPilot page.

Logging in to environments with multiple CallPilot servers
My CallPilot has enhanced support for environments that have multiple CallPilot 
servers. If this applies to your situation, a drop-down menu containing multiple CallPilot 
servers appears in the Log in page. 

Selecting a server from this list allows you to select (and log in to) your CallPilot server 
without needing to know any of your server-specific settings (beyond your mailbox and 
password). 

This feature is implemented as simple text-based file (cpserverlist) that an administrator 
can create using the My CallPilot Administration Utility.
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CallPilot Messages tab

To access your CallPilot messages, click the CallPilot Messages tab. You can access 
voice messages and view faxes, delete, forward, and reply to messages, and 
compose new messages.

Your Message List

To check for new messages
To see new messages, click Refresh. New messages appear in Bold.

You can sort your mailbox message list through the Read/Unread, Priority, and Subject 
columns, as well as the From and Received columns.

The messages are sorted by simply clicking on the column headings.  

Note: Only the messages currently displayed are sorted, which may not be the entire 
message list.

To open a message
To open a CallPilot message, click the voice, fax, or text icon in the Attachments column 
beside the message, or click any underlined part of the message line. See Playing 
voice messages, on page 18, and Viewing fax messages, on page 20.

To select a message 
To select a CallPilot message, check the box at the far left of the message line. When a 
message is selected, you can delete, forward, or reply to it.

Use the 
embedded 
CallPilot 
Player, if 
available, to 
play and 
record voice 
messages

Messages tab

Attachments:
Voice

Text
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To delete a message
To delete a CallPilot message, select the message and click Delete or Delete Now. If 
you click Delete, the message is permanently deleted when you log out. If you click 
Delete Now, all selected messages are permanently deleted immediately.

To select your telephone or computer to play and record voice messages
You can choose to play and record voice messages through your telephone or your 
computer. Click the Telephone or Computer icon in the embedded or downloaded 
CallPilot Player. (To record and play messages using the telephone, you must have a 
properly configured firewall, or no firewall between you and the web server.) 

See Setting messaging preferences, on page 57, to change the audio setting and the 
number that CallPilot dials for playing and recording messages.
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Playing voice messages

Before playing voice messages, see To select your telephone or computer to play and 
record voice messages, on page 17.

To play a voice message the quick way (Windows only)
Use the embedded CallPilot Player, if available, to play your voice messages quickly. 
(The player appears in your Message List if the Attachments column appears, and if you 
select VBK as your audio setting. See Setting messaging preferences, on page 57. 
Note that the player can also play WAV format audio files.) 

1 In your Message List, click the Voice (Play) icon in the Attachments column. 
When the audio controller window appears (Windows version shown below), 
press the Play button if playing does not start automatically.

2 If you selected Computer for playback, the audio player plays your message 
from your computer’s speakers.
If you selected Telephone for playback, your telephone rings and plays the 
message when you answer.

3 Use the player buttons to stop, re-play, or call the sender. The slider control on 
the player permits positioning within a recording. Note that the volume level and 
the play rate (speed) cannot be adjusted when using the embedded player.

4 Click Disconnect or hang up the telephone when you are finished.

To play a voice message in a mixed voice, fax, or text message
In a mixed voice, fax, or text message, open the message to select each part.

1 In your Message List, click any underlined part of the message to open it.

2 In the open message, click the Voice icon. The audio player opens.
3 If you selected Computer for playback, the audio player plays your message 

from your computer’s speakers.
If you selected Telephone for playback, your telephone rings and plays the 
message when you answer.

4 Use the player buttons to stop/pause, re-play, or call the sender (Windows only). 
Other controls on the player also permit absolute positioning within a recording, 
volume level adjustment, altering the play rate (speed), and disconnecting 
(hanging up). 

Note: On the Macintosh CallPilot Player, there is no Stop button. When you click the 
Play button, play begins and the Play button then becomes the Pause button. In 
addition, the audio control commands can be accessed through the Audio menu of the 
Macintosh CallPilot Player.

Play messages 
from computer 
or telephone

Play/Re-play      Stop           Disconnect      Call Sender

Embedded Windows 
CallPilot Player

Controls on other audio 
players vary



19

5 Click the Disconnect (Windows) or Hang Up (Mac) button, or hang up the 
telephone when you are finished. Click Message List to return to your messages.

Note for Linux users:

Linux users can view and play (through any WAV player) their CallPilot messages in the 
Mozilla browser.  However, there is no VBK playback or recording. Users can see their 
text and listen to audio messages using the WAV audio format.

Return to
messages

Reply to,
forward,  or
delete this
message
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Viewing fax messages

To view faxes on your computer, you must have ImageMaker or other imaging software 
installed on your Windows-based computer. For Macintosh users, the CallPilot Player 
application is used to view faxes. In addition, your CallPilot administrator must enable 
fax capability for your mailbox in order for you to receive faxes.

To view a fax message 
1 In your Message List, click the Fax icon beside the message, or click any 

underlined part of the message that you want to view. 

2 The image may display right away, or if the Open/Save dialog box appears, 
select Open to display the image. The fax can then be scaled to its normal 
(printed page) size, to an enlarged view that still fits on typical displays, to a 
maximum size where every pixel is visible, or to a view where a fax page is made 
to fit the current window size. The fax document may also be rotated to 90, 180, 
or 270 
(-90) degrees.

3 When you have finished, close the fax image to return to your messages.

Note: If you use Windows imaging software other than ImageMaker or if you work on a 
Macintosh, the appearance of the fax message may differ from the one shown. In 
addition, some of the controls seen here, such as Zoom in and Zoom out, may not be 
available. 

Print Change 
page

Rotate

Fit width

Zoom in/out
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In the Macintosh CallPilot Player, the control commands are accessed through the Fax 
menu.

Note: Nortel Player is not provided for Macintosh OS X. 
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Composing voice messages

You can compose a message that is any combination of voice, fax, or text. To record 
voice messages, use the embedded or the downloaded CallPilot Player. 

Allow User to send voice messages to non-CallPilot recipients 
(for CallPilot server release 3.0 and above)

The system administrator has control over the distribution of CallPilot voice messages 
outside of the organization. Allow user to send voice message to non-CallPilot 
recipients - if the system administrator leaves this option unchecked, the user is unable 
to save or forward audio attachments or voice messages to non-CallPilot recipients.

Note: If the user attempts to forward a voice message to a non-CallPilot recipient 
using Microsoft Outlook, standard e-mail form, the operation appears to have 
functioned properly. The recipient of the message only receives the VBK header. 
The audio data is not sent, and the message cannot be played.
If Allow user to send voice messages to  non-CallPilot recipients is unselected (not 
checked) you are not able to forward voice messages to non-CallPilot addresses. 
However, you are still able to forward voice message to CallPilot addresses.

Note: If Allow user to send voice messages to  non-CallPilot recipients is 
unselected (not checked) the user is not blocked from forwarding voice messages to 
an external e-mail account if they are using Internet IMAP clients (Outlook Express, 
Eudora, or Netscape Messenger).
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To record and send a new voice message 
1 In your Message List, click Compose. A new message page opens.

2 Click To… (or Address Book) to choose an address from the CallPilot Address 
Book, or click Special Addresses. See Addressing messages, on page 33.

3 Add a subject description in the Subject text box.

4 In the embedded or downloaded Windows CallPilot Player, select the Telephone 
or Computer icon. If you are using a Macintosh, select either Use Telephone or 
Use Macintosh from the CallPilot Player’s Audio menu.

5 Click the Record button.

Note:  You can only record into a new audio window, not to audio files that exist 
in your inbox.

Note:  The embedded player does not permit adjustment of the recording 
volume.

Use 
telephone 
or computer 
icon to 
record 

Start new 
voice 
recording

Save voice 
recording 
and attach 
it  to this 
message

Disconnect 
after 
recording

Play/Review   Stop   Record   Playback sliderInterface showing Embedded Player
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Note: In the Macintosh CallPilot Player window (QuickTime version 5.0, shown 
below), there is no Stop button.

When you click the Record button, recording begins and the Record button then 
becomes the Pause button.

6 � If you are recording from the computer, record your message into the 
microphone. Click Pause to pause the recording. Click Stop to end the 
recording. Click Play to review it. To add to the recording, click Record, speak 
again, then click Stop. Click Save Audio. 
� If you are recording from the telephone, answer when the telephone rings. At 
the tone, record your message into the handset. Click Pause to pause the 
recording. Click Stop to end the recording. Click Play to review it. Click Save 
Audio. Hang up.
Note:  Saving your audio works a little differently depending on which version of 
the CallPilot player you are using. If you use the embedded version, the Save 
Audio button only saves the message as an attachment to the current message. 
If you use the downloaded (stand-alone) version, you save the recording as a 
file, which you then attach to your message. 

7 If you are using the stand-alone version of the Player, add your voice message 
file as an attachment and set options if required. See Adding attachments to 
messages, on page 31, and Setting message options, on page 32.

8 Click Send.

To save a newly created voice message as a file
To save a copy of your voice recording as a standalone file you must use the 
standalone CallPilot Player, not the embedded Player.

1 Open the CallPilot Player, record a new message, and on the File menu, click 
Save or Save As.

2 In the File name box, type a name for the file, select a folder to keep the file in, 
then click Save. Save voice files as VBK files. 
Note: My CallPilot automatically converts VBK files to WAV files when sending to 
non-CallPilot users.
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Composing fax and text messages

Your CallPilot recipients must have fax capability to view your fax on their computer. If 
your recipients access their messages from their telephone, they can view the fax only 
by printing it. You can also send your fax to a fax machine.

To create and save a fax file
To create a fax file, your CallPilot mailbox must have fax capability, and your computer 
must have Desktop Messaging installed. After you save the fax file, you can add the fax 
to a message as an attachment.

1 Launch the application you want to use to create a fax with. The document you 
open or create must be 8.5 in. (21.5 cm) wide or less. Multiple page documents 
are allowed.

2 When the document is ready:
� Windows computer: 

a. Click Print or Print Setup under the File menu.

b. From the list of printers, select Nortel Fax.
� Mac computer:

a. First select the Chooser desk accessory from the Apple Menu.

b. Then select the CallPilot Fax icon and close the window. 
3 Click OK.

4 In the Compose Fax dialog box, click Save As. 

Compose Fax dialog box - Windows version

View before 
sending

Delete before 
sending

Change order 
of files to be 
faxed

Browse to 
select 
predesigned 
cover page

File name

Send fax

Save to send
later
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Compose Fax dialog box - Macintosh version

5 Type a name for the file, and browse to select a folder to save the file in. Save the 
file as a TIF file. Click Save.

Note:   If you chose to include a Subject line, the information in that text box is 
displayed in the e-mail portion of the fax. The Subject line is not displayed on a hard 
copy of the fax.

6 Click Exit to close Compose Fax.

To compose and send a fax or text message
1 In your Message List, click Compose. A new message page opens.

2 Click To… (or Address Book) to choose an address from the CallPilot Address 
Book, or click Special Addresses. See Addressing messages, on page 33.

3 Add a fax file as an attachment. See Adding attachments to messages, on page 
31.

4 Add options if required. See Setting message options, on page 32. 
5 Enter text if required.

6 Click Send.

Note for Linux users:

Fax viewing or sending is not supported at this time.
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Calling the sender of a message

You can respond to a message with a telephone call instead of a recorded message.

My CallPilot includes a Call Sender button that appears in both the Message List and 
Open Message views. Clicking the Call Sender button calls the sender of the 
currently selected message, regardless of whether or not the message contains an 
audio attachment. 

The Call Sender button only appears when all of the following conditions are met:

The Mailbox Class allows the Telset Class-of-Service

Messages are being viewed on the CallPilot server
When the Call Sender button is pressed, depending on whether CallPilot is installed 
on the client computer or not, an appropriate dialog box appears asking you to verify 
the phone number.

The Remember changes check box associates the new phone number with the 
original. Subsequent calls to the same sender auto-fill the Verify number field with 
the new phone number.  The maximum number of digits that can be entered is 50.

The Call Sender button causes your telset to ring. When you answer the call, your 
telset is connected to the specified phone number.

This Make Call feature contains no error detection after the call has been placed, 
and My CallPilot does not have control over the call or your telset after the call has 
been placed.

My CallPilot also includes a new Directory Call button in the Address Book Search 
view. This button only appears when you compose a message on your CallPilot 

CallPilot 
Not 
installed

CallPilot Is Installed
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server.

Selecting an Address Book entry and clicking Directory Call extracts the entry's 
phone number. This phone number is then displayed in the Call Address Book entry  
dialog box.

Note: The above dialog box appears if CallPilot Player is not installed on the client 
computer.
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Clicking on Call User causes your telset to ring. When you answer the call, My 
CallPilot calls the specified phone number.

Note that the Restriction Permission List defined in CallPilot Manager is not checked 
before attempting to dial the digits.  If the phone number is rejected by CallPilot or 
the switch, no error dialog box appears.

Note: If the field Number to call for Telset Playback (ie. your phone) is blank, go 
to the My CallPilot Features tab and select My CallPilot Preferences and enter the 
number at the top of the page, in this example 4300,  in the Number to call for 
Telset Playback (ie. your phone) field and click the Save button. .
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Forwarding and replying to messages

You can forward a message, and compose an introduction to send with it. You can also 
compose a reply to the sender of a message, or to the sender and all recipients of a 
message.

To forward or reply to a message
1 In an open message, click Forward, Reply, or Reply All.

2 On the new message page, compose a voice, fax, or text message. 

3 Address forwarded messages the same way as a new message. Replies are 
addressed automatically.

4 Add attachments, set options, and change the Subject line if required.
5 Click Send.

Attach fileType text message
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Adding attachments to messages

Before sending a message, you can attach one or more voice, fax, or text files to it. 
Voice files can be either VBK or WAV format for both Windows and Macintosh CallPilot 
recipients. My CallPilot automatically converts VBK files to WAV files when sending 
to non-CallPilot users. Fax files must be TIF format. Text files must be TXT format. 

To attach a file to a message
1 On a new message page, click Attach Files... .
2 In Add Attachments, click the browse button to browse for and select the files 

that you want to attach. 

3 Click Open.

4 Click Attach Selected File button.

5 Click OK. The icon for the attached file appears beside the Attach Files button 
on the new message.  

6 Continue to compose, address, and send the message as usual.
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Setting message options

Before sending a message, you can set options for handling and delivery.

To set message options
1 On a new message page, select Priority, Sensitivity, and Receipt options, as 

required.

� For Priority, select Low, High, or leave the setting as Normal.
� For Sensitivity, select Private, or leave the setting as Public. 

You cannot forward messages that are marked Private to other CallPilot users. 
However, be aware that when you send a message marked Private, your recipient 
can still forward the message to someone else, if the recipient is not a CallPilot user. 
Also, recipients in non-CallPilot systems are not informed of Private settings. In your 
message, tell the recipient that the message is private.

� For Notify me when message is read checked, check the box to request 
acknowledgment that your recipient received the message.

2 Continue to compose, address, and send the message as usual.
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Addressing messages

You can address a CallPilot message in two ways: 

You can select a name from the CallPilot Address Book that is maintained by your 
organization on the server. The Address Book contains the addresses of the 
CallPilot users and shared distribution lists that you can use. You cannot edit this 
list.

You can manually enter or select addresses on other servers in Special 
Addresses.

To address a message from the Address Book 
1 In a new CallPilot message, click To (or Address Book).
2 In Enter last name, type the recipient’s name, then click Find.

3 In the list of names, select the name of the recipient or distribution list.

4 Click To. You can select one or more addresses, clicking To after each one.

5 Click OK to return to the new CallPilot message.

To address a message in Special Addresses
1 On a new message page, click Special Addresses.
2 Select an address format from the drop-down list (for example: Network mailbox 

or Personal Distribution List). Note that Personal Distribution List entries appear 
alphabetically sorted when doing an Address Book search.

3 Type the number and any other information required. Refer to the online Help for 
the correct addressing formats.
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4 Click To.

Searching External E-mail Address Books (LDAP databases)
The LDAP text boxes you can specify for your e-mail account (refer to  Setting up links 
to your e-mail accounts, on page 53) allow My CallPilot to search external LDAP 
databases, which in turn allows you to search for an e-mail address in your corporate 
Address Book.    

Note: This ability requires the administrator to enter the correct searchbase, host/IP 
and login info (if needed) for the external LDAP server. This information must be 
entered in CallPilot Manager when the External E-mail server is defined.  

You can enter user log in credentials, if needed, inside My CallPilot.  

Once these text boxes are properly configured, you can search the external Address 
Book when composing a new external e-mail server message (just as you do when 
composing a CallPilot message).  

To access the Address Book, you simply click on the Address Book button, or To links 
in the My CallPilot Compose page.

The following shows an example of an external e-mail server Address Book in My 
CallPilot:

Note that the Address Book is tied to the current server you are using (that is,  the inbox 
you are displaying).  Therefore, when you compose a new CallPilot message, the 
Address Book displays addresses only from the CallPilot server. When you compose a 
new Exchange message, the Address Book displays addresses only from the 
Exchange server, and so on.

Non-personal distribution lists can appear in the results if, and only if, the server is 
configured to return them through a standard anonymous LDAP query.
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CallPilot Features tab
Click the CallPilot Features tab to change the settings for your CallPilot features and 
telephone options, and to set preferences for web-based access.

The main CallPilot Features page displays only the features that are available for you to 
use. Click any title to open its settings page. 
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Greetings

The Voice Greetings feature allows you to record and manage your voice greetings and 
personal verification from My CallPilot.

Selecting the Greetings link loads the Greetings page. From this page, you can record, 
play, delete, and import voice greetings and personal verification. The Greeting page 
also shows the greeting status (recorded/not recorded) and allows you to assign expiry 
dates to a temporary greeting.

The CallPilot Player is required to record/play greetings or personal verification from My 
CallPilot. An alert appears if CallPilot Player is not installed and you try to play/record 
greeting/personal verification.

You can import VBK and WAV-PCM files for greetings and personal verification 
messages. The files can be imported with or without the CallPilot Player. If the CallPilot 
Player is not installed, you can record/save a WAV-PCM file from another media 
application and import the WAV-PCM file using My CallPilot.

For Internet Explorer users:
If the CallPilot Audio Player is present, the audio player is embedded directly in the web 
page.
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1 Click the Edit button to activate a specific greeting. When activated, the greeting 
text is shown in a bold italic font. 

2 You can then use the embedded audio player to play the greeting, record a new 
greeting, or add to the greeting. You can record a greeting using your telset.  

3 Press the Save Greeting button to make the changes permanent.  If you do not 
press the Save Greeting button, an alert appears.

For Netscape Navigator users:
If you are using Netscape Navigator, the stand-alone audio player is used to record and 
play voice greetings and personal verification. The CallPilot Player can be launched by 
pressing the Edit button, or from the Windows Start menu.
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Recording a greeting
Record a greeting using CallPilot stand-alone player or any other media applications 
that support WAV-PCM format as follows: 

1 Record a voice greeting or personal verification using the CallPilot Player. To use 
the telset, you must log into the CallPilot server.

2 Save the recording as a WAV file.
3 Press the Import button to upload the saved file.

Note: You are not able to play existing greeting/personal verification if CallPilot 
Player is launched from Windows Start menu.

4 The Import dialog box appears. This page allows you to select which VBK or 
WAV-PCM file on the local computer to upload to the CallPilot server. The 
selected file is uploaded when the Save button is pressed.

The CallPilot Player launched from My CallPilot  Greetings page allows you to record 
and save a recording directly from the player using the player's File-Save menu, 
skipping the Import step. 

You can also play previously recorded greetings or personal verification. However, no 
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computer playback is available if only your telset is used. Since the player shares the 
same credentials with My CallPilot, no login to the CallPilot server is necessary. The 
only requirement is that you do not close the browser window while working with a 
greeting, or the recording could be lost.  

Once you are done with the greeting, you should refresh the Greetings page to update 
the page content.

Setting an expiry date
You can also set an expiry date for temporary greetings from the Greetings page. The 
expiry date/time corresponds to the date/time on the CallPilot server. The expiry date is 
validated by My CallPilot.

Removing voice greetings and personal verification
Voice greetings and personal verification can be removed by pressing the Delete 
button. You must confirm the deletion before the voice greeting or personal verification 
is removed.

Personal Verification allows you to record your name in your own voice, so callers can 
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correctly identify you when leaving a voice message.
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Setting up message notification
CallPilot can notify you of new messages when you are away from the office. Your 
administrator defines whether these devices and services are available to you:

Remote Text Notification to a wireless e-mail device. See Appendix A: Remote 
Text Notification for Microsoft Outlook and BlackBerry Devices, on page 63.

Remote Notification to a telephone or pager. This type of remote notification can 
be set up and turned on or off from your telephone as well. You can set up two 
time periods for notification, and choose whether you want to be notified of all 
messages or urgent messages only.

You can have the two types of notification turned on simultaneously.
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Setting Up Message Forwarding

Clicking the Message Forwarding Rule link loads the Message Forwarding Rule 
page. This page provides the interface to:

Create a rule

Delete an existing rule

Edit an existing rule
Enable or disable a rule

A rule must be enabled to be active. A new rule is enabled by default. A maximum of 
one rule per CallPilot mailbox is supported.

Clicking the Configure Rule button loads the Message Forwarding Rule Configuration 
page. This page provides the interface to:

Determine which messages are forwarded
Enter a single e-mail address or CallPilot address where the message is to be 
forwarded
Specify when to mark the original message as Read

Determine if the voice portion of the message is to be converted to WAV
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The supported "Messages to forward" options are:

All Messages (default selection)

Voice Messages
Fax/Text Messages

The recipient can be either an E-mail (default) or CallPilot address. All Message 
Forwarding Rule options are supported for e-mail addresses. The options Convert 
voice to WAV-PCM and 'Opened by recipient' are not supported for CallPilot addresses.  
Also, the WAV PCM selection is grayed if Fax/Text Messages is selected.

Only one address is permitted per rule. Simple address validation is performed on the 
e-mail address. The e-mail address can be a maximum of 255 characters. The address 
is scanned to ensure the address contains a period and the at (@) sign. The address 
validation is performed when the user presses the Save button.

CallPilot distribution lists cannot be manually entered here. However, e-mail distribution 
lists are supported. An E-mail distribution list can be entered as an e-mail address in the 
Message Forwarding Rule.
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The user can also select the CallPilot hyper text link to select or enter a CallPilot 
address. The CallPilot Address Book dialog box is displayed when the CallPilot link is 
selected:

You can also create and address manually using the address creation dialogs. PDLS, 
SDLs, BDLs, telephone numbers and fax addresses are not accepted.  Users wishing 
to forward CallPilot messages to a telephone number should use the CallPilot Remote 
Notification feature.  Users wishing to forward incoming fax messages to a fax number 
should use the CallPilot Fax Printing feature. An Address creation dialog box is 
provided for a CallPilot mailbox and for an Open VIPs CallPilot mailbox, as follows:
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CallPilot mailboxes can be expressed as follows:

LOCAL: <local VPIM prefix><mailbox>@<local FQDN>
Open VPIM: VPIM=<VPIM shortcut><mailbox>/<remote FQDN>@<local FQDN>
Remote Mailbox: <remote location VPIM prefix><mailbox>@<local FQDN>

If a CallPilot address type other than a CallPilot mailbox or an Open VPIM address is 
entered, a warning dialog box is displayed when Save is selected from the Configure 
Message Forwarding Rule page.

If the "Mark original message as read when" check box is checked, the following 
choices are available:

Forwarded by this service (default selection)

The original CallPilot message is marked as read as soon as the message is 
forwarded to the recipient.

Opened by recipient
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The original CallPilot message is marked as read when the forwarded message 
is opened by the recipient.  The feature makes use of the read receipt capability 
of the e-mail server to whom the message was forwarded. When the read receipt 
is received by CallPilot, the original message is marked as read.

Note: When the message is opened by the recipient an internal message 
identification is added to the subject, and permits Message Waiting Indicator 
(MWI) light to extinguish, when the message is read.

This feature is not supported by CallPilot systems and the option is disabled if a 
CallPilot address is selected. Also, not all e-mail servers support Read Receipts. 
Yahoo Mail does not, and Exchange 5.5 requires Service Pack 2 to fully support 
Read Receipts. You determine if the e-mail system supports Read Receipts. See 
the following Microsoft Knowledge Base article (KB217160) for an explanation of 
the issue with Exchange 5.5: http://support.microsoft.com/
default.aspx?scid=http://support.microsoft.com:80/support/kb/articles/q217/1/
60.asp&NoWebContent=1

By default, voice messages are sent in VBK format. You can choose to convert voice 
messages to WAV. Note that there is currently no CallPilot Player available for 
Macintosh OS X, Linux, or PDAs. These clients only support WAV playback.

There are advantages to sending messages in VBK format.   While the CallPilot Audio 
Player does need to be installed on the client, you are able to play CallPilot messages 
over both the telephone and computer speakers, speed up or slow down playback 
speed, and have a link to My CallPilot. Additionally, the VBK file is three to five times 
smaller than the same message transcoded to WAV, so the download time and 
network bandwidth requirements are lower.
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Managing personal distribution lists

A distribution list saves you time when you send messages to the same group of 
addresses. You can create up to 99 personal distribution lists, and enter a number and 
name to identify each list. Each personal distribution list can contain up to 200 entries. 

A personal distribution list can contain any addresses to which you can send a  
message, except other personal distribution lists. An entry can be a mailbox number, 
shared distribution list number, network mailbox, open network mailbox, or telephone 
number.  

You can create personal distribution lists in My CallPilot or on your telephone. These 
lists are stored for you in the CallPilot Address Book on the CallPilot server. You can 
access these lists from My CallPilot, Desktop Messaging, and your telephone.

To edit, delete, or create personal distribution lists
To edit or delete an existing list, select the list and click Edit or Delete. Make the 
changes, then click Save.

To create a personal distribution list, click Add New List. Type a number and name for 
the list. Add entries by selecting an address format from the drop-down list, then enter 
the information required. Refer to the online Help for the correct addressing formats, if 
required. Click Save.
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Changing your CallPilot password

Your CallPilot password is the same password that you use to log in to CallPilot from 
the telephone. CallPilot requires that you change your password on a regular schedule 
set by your administrator.

CallPilot prevents you from using some passwords if they are too short or too simple, or 
if you have used the same one recently. Keep your mailbox secure by choosing 
passwords that are not easily discovered. 

To change your password, type your old password, type your new password twice, then 
click Save. 
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Changing your telephone options

To assign a custom operator number for callers
You can offer your callers the option of leaving a message or speaking to one of your 
assistants or colleagues. In your greeting, tell callers to press zero if they wish to speak 
to this person in your absence. The custom operator number is the number your callers 
reach when they press zero. Enter the number in Telephone Options.

To set times and options for blocking messages from callers
You can temporarily prevent your callers from leaving messages in your mailbox. You 
can choose to transfer callers to your custom operator, or disconnect them. As a 
courtesy to your callers while Message Blocking is turned on, record a temporary 
greeting that provides details of your absence and tells callers what to do. Select the 
settings in Telephone Options.

To turn Auto Login on or off and define allowed numbers
When Auto Login is turned on, you do not have to enter your mailbox and password 
when you log in from a defined number. Your administrator defines secure numbers for 
Autologin, such as your office or home telephone. When Autologin is turned on, you 
access your mailbox by dialing the CallPilot access number or pressing the message 
key at one of your defined Autologin numbers. To turn on Autologin, check the box in 
Telephone Options. 
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To enable or disable Message Waiting Indicator Dialing Numbers
Message Waiting Indicator Dialing Numbers (MWI DN) are assigned by the 
administrator. The mailbox subscriber is not allowed to change the numbers. However, 
the mailbox subscriber can see these MWI DNs in the Telephone Options section, and 
can enable or disable them individually. Only non-empty MWI DNs are displayed.
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Setting up telephone access to e-mail

To set up access to your e-mail accounts from CallPilot, see Setting up links to your e-
mail accounts, on page 53. You can specify one of these e-mail accounts for telephone 
access so that you can check for new e-mail messages while logged in to CallPilot from 
your telephone. You can have the text content of any new e-mail messages read to you 
over the telephone.

To set up an e-mail account for telephone access
1 Open the E-mail By Phone page. Your e-mail account links are displayed.

� To set up or edit a mailbox link, click Configure New Mailbox Link. 
See To set up an e-mail link, on page 53.

2 Select one e-mail account for access by telephone.

3 Select a female or male voice to read your e-mails.
4 Click OK.
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Changing fax printing options

If your CallPilot mailbox has fax messaging capability, you can receive a fax message in 
your mailbox and print the fax at a selected fax number. Set options for default fax 
number, Auto printing, and print cover page on the Fax Printing page.

To change the default printer
You must set a default fax number. If you are not using Auto printing, a default fax 
number is the simplest way to print. The default number can be any fax number that 
CallPilot can dial, including any normally required prefixes. 

To turn Auto printing on or off
When Auto printing is turned on, any faxes that arrive at your mailbox are automatically 
printed at a specified default fax number. A message that has been auto printed 
remains in your mailbox so that you can reprint the message or forward the message. 
Your printed faxes can be deleted automatically from your mailbox on a schedule set by 
your administrator.

Auto printing is the most convenient way to handle fax messages while you are in one 
location. If you are away from your office, you can turn Auto printing off and print your 
faxes at another fax number. 

To turn fax separator page printing on or off
You can select whether to print a fax separator page when you print a fax message. A 
separator page identifies you and gives details of the print job, such as the number of 
pages. Separator pages are useful if you receive faxes without cover pages. If the 
sender of the fax includes a header page with the fax, the header page also prints.
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Setting up links to your e-mail accounts

You can set up links in CallPilot so that you can check your e-mail for new messages. 
You can also forward and reply to messages, and send new e-mails.

You can define up to five e-mail accounts. One of these accounts can be set up for 
access from your telephone. See Setting up telephone access to e-mail, on page 51. 
The selected account shows a check mark under Enabled for E-Mail By Phone.

To set up an e-mail link
1 On the Mailbox Links page, click Configure New Mailbox Link.

2 Select your e-mail server from the drop-down list. To get this name, look in the 
account settings of your e-mail application, or ask your administrator.

3 Type a name for this account to display on the tab.
4 Type the name of the folder to access for your e-mail messages, such as Inbox.

5 Type your e-mail address. 

6 Type your mailbox user name (the User ID of your e-mail account).
7 Type the password for this e-mail account.

8 Retype the password for this e-mail account to verify the password.

9 Click Save. The password is encrypted for security.
You can edit this information at any time, or delete the account.

Remember that whenever you change your e-mail password, you must change the 
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password in My CallPilot as well.

To configure an external e-mail server
My CallPilot supports various settings when configuring an external e-mail server.   
Some of these settings are configured in CallPilot Manager, while others are specified 
in My CallPilot. This allows My CallPilot to work correctly in situations where the user's 
corporate IMAP, SMTP and LDAP servers are on different hosts.  

The settings include the host/IP address and port number of the SMTP server, and 
numerous external LDAP server settings. Consult your administrator if you are required 
to change these settings and are uncertain of the appropriate entries.

Note: If the corporate e-mail servers (IMAP, SMTP, and LDAP) support SSL (Secure 
Port), the administrator should check the corresponding "This server requires a 
secure connection" check box to ensure that CallPilot Manager also uses SSL.  
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1  On the Mailbox Links page, click Configure New Mailbox Link. The Configure 
New Mailbox Link page opens. 

2 Select your e-mail server from the drop-down list. To get this name, look in the 
account settings of your e-mail application, or ask your administrator.

3 Type a name for this account to display on the tab.
4 Type the name of the folder to access for your e-mail messages, such as Inbox.

5 Type your e-mail address.

6 Type your mailbox user name (the User ID of your e-mail account).
7 Type the password for this e-mail account.

8 Retype the password for this e-mail account to verify it.

9 In the Outgoing mail server (SMTP) block, check the This server requires a 
user name and password logon box. 

10  Type your mailbox user name (the User ID of your e-mail account). 
11 Type the password for this e-mail account. 

12 Retype the password for this e-mail account to verify the password. 
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13 In the Directory service (LDAP) block, check the This server requires a user 
name and password  logon box. 

14  Type your mailbox user name (the User ID of your e-mail account). 

15 Type the password for this e-mail account.

16 Re-type the password for this e-mail account to verify it.
17 Click Save.

These settings allow My CallPilot to be  configured easily to work in nearly any 
corporate e-mail environment. The LDAP text boxes, in particular, allow for the external 
Address Book searching feature. Note that you do not have the ability to specify the port 
numbers; these are defined by the administrator in CallPilot Manager.

Note: To log in anonymously uncheck This server requires a user name and 
password, for both SMTP and IMAP.
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Setting messaging preferences

To change Message List columns
You can change the columns in your Message List. The Attachments option must be in 
the Displayed Columns list to see the embedded player (Windows only) in your 
Message List. 

To add a signature
Type or paste your signature and other information, then click the check box if you want 
this signature added automatically to outgoing text messages.
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To change environment settings
Change any of these My CallPilot settings to your preferences.

Note: The Remove Deletable items on Logout check box applies to both regular 
e-mail messages as well as messages you access when using e-mail by Phone. 
This check box must be selected to enable the removal of messages that you have 
deleted when you logout.

Macintosh Preferences window
The Preferences option under the Edit menu allows the following user settings to be 
saved for the CallPilot Player application on the Macintosh.

The defaults are: Macintosh audio device, all settings checked.

Note: You may see the Audio Device section "grayed out." This happens if the 
Mailbox class is set to restrict you to a specific device (telephone or PC/Mac).
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Choosing a home page for My CallPilot

Choose the page that you want to display automatically when you log in to My CallPilot.
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E-mail tab

While you are logged in to My CallPilot, you can check your e-mail messages. You can 
forward and reply, and send new e-mails. See Setting up links to your e-mail accounts, 
on page 53. 
You can access up to five IMAP e-mail accounts, or other CallPilot mailboxes. One of 
these accounts can be set up for access from your telephone. See Setting up 
telephone access to e-mail, on page 51. 

You can also set up access to a second CallPilot mailbox, which can be on another 
server. For setup details, refer to the online Help. 

Each e-mail tab shows the name of the account associated with that tab.

To open a message
To open an e-mail message in My CallPilot, click the icon in the Attachments column 
beside the message, or click any underlined part of the message line.

To delete a message
To mark an e-mail message for deletion, select the message and click Delete. To 
ensure that deleted messages are permanently deleted, open the My CallPilot 
Preferences page, and in Environment Settings, check the Remove Deletable items on 
logout check box.

To compose and send a new message
To compose a new e-mail message, click Compose, type the message, and send the 
message the same way as a CallPilot message. The Address Book is not available.

To forward and reply to messages
You can forward and reply to e-mails in the same way as CallPilot messages, except 
that the Address Book is not available.
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Useful Information tab

Click the Useful Information tab to:  

View status and details about your mailbox.

View online user guides.
Print online user guide files on your laser printer.
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Protecting the security of your mailbox

Because My CallPilot is a web-based product, it is important to take precautions to 
protect the security of your mailbox.

If your administrator has enabled SSL encryption, you can use the Secure Login 
feature for greater security. See To log in using secure login, on page 14.
When you have finished using My CallPilot, make sure that you log out. If you go 
to a web site outside of My CallPilot without logging out, CallPilot does not log out 
immediately. This can make your CallPilot information vulnerable to hackers. If 
you want to visit a web site without exiting My CallPilot, use a separate browser 
window to view the other site.
You can set CallPilot to log out automatically after a short time, such as 5 or 10 
minutes. See Setting messaging preferences, on page 57.
If you use a public or shared workstation, avoid using the Remember Password 
option when you log in to My CallPilot. If this option is selected, others can 
access your CallPilot mailbox.

If you use a public or shared workstation, you should empty the browser cache 
after a CallPilot session. For information about your browser cache, see your 
browser online Help.
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Appendix A: Remote Text Notification for Microsoft 
Outlook and BlackBerry Devices

Remote text notification can be configured to send a message to your SMTP e-mail 
account when a new voice, fax, or text message arrives in your CallPilot mailbox. You 
can set up notification to any e-mail server that supports SMTP. These include most 
e-mail accounts, wireless handheld organizers, mobile phones, or PDAs like the 
Research In Motion Blackberry.

To set up My CallPilot for remote telephone or pager notification, see Setting up 
message notification, on page 41.

This section describes how to set up remote text notification for Microsoft Outlook and 
BlackBerry devices. Any device or portal with a service provider that supports SMTP 
can receive e-mail notification messages. If you plan to use another type of device to 
receive remote text notification, ask your CallPilot administrator about any additional 
setup that is required for your device.

To receive notification messages on a Research In Motion (RIM) BlackBerry Internet 
Edition device, you must configure Microsoft Outlook and BlackBerry Desktop Manager 
(version 2 or later) to forward CallPilot notification messages to your BlackBerry device. 

If you use a BlackBerry Enterprise Edition device, your administrator can set up 
notification message forwarding for you on the e-mail server or configure BlackBerry 
Desktop Manager to redirect CallPilot notification messages.

Note: If you set up My CallPilot to send CallPilot notification to your Outlook Inbox, 
and set up BlackBerry Desktop Manager to send all incoming messages to your 
Blackberry device, your CallPilot notification messages appear in your list of e-mails 
on your Blackberry device with no additional configuration required.

Notification message format
An e-mail notification message can show the: 

type of message

name of the person who left the message, if available
telephone number, if available

For example, John Smith calls from extension 1234 and leaves a voice message for 
Andrew Jones. An e-mail message is sent to Andrew Jones with the following text:

You have a voice message from John Smith [1234]

Microsoft Outlook forwards this e-mail message to Andrew’s BlackBerry device. The 
message appears with the subject CallPilot Notification. Once Andrew receives the 
message, he can decide whether to retrieve the message from CallPilot or to call John 
immediately, using a telephone.
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Getting started with remote text notification

Requirements
You need a BlackBerry device. Ensure that e-mail service on your BlackBerry 
device is working. 

Microsoft Outlook must be installed. Currently, BlackBerry Desktop Manager only 
works with Microsoft Outlook. Consult your BlackBerry documentation for 
information about other e-mail clients.
BlackBerry Desktop Manager 2 or later must be installed and running on your 
computer.
Remote text notification capability must be enabled and set up for your mailbox 
by your CallPilot administrator.
Remote text notification must be configured and enabled in My CallPilot. For 
more information, see Setting up message notification, on page 41.

Configuration steps
Complete the following steps to effectively manage e-mail notification messages.

Step Reference

Create a holding folder for your e-mail 
notification messages so that they are stored 
separately from your other messages.

If you want to forward all messages in your 
Outlook inbox to your BlackBerry device, you 
can skip this step.

“Creating a notification holding folder” 
on page 65

Configure BlackBerry Desktop Manager to 
forward messages to your BlackBerry device. 

“Configuring BlackBerry Desktop 
Manager” on page 68

If desired, configure Outlook to delete old 
CallPilot notification messages automatically 
from the holding folder.

Alternatively, you can manually delete 
notification messages from the holding folder.

“Automatically removing notification 
messages” on page 69



65

Creating a notification holding folder

You can create a holding folder for your CallPilot e-mail notification messages so that 
they are stored separately from your other messages. To store messages in the folder, 
follow these steps:

1 Create an Outlook folder for the notification messages.

2 Configure Outlook to route CallPilot notification e-mail messages to the folder 
using the Rules Wizard.

To create a notification folder
1 Start Outlook.

2 In the Folder List, select Outlook Today.
3 From the File menu, choose New > Folder. The Create New Folder dialog box 

appears.
4 In the Name box, type CallPilot Notification, and then click OK. The CallPilot 

Notification folder appears in the Folder List. 

To route notification messages to the holding folder
1 Choose Tools > Rules Wizard. The Rules Wizard dialog box appears.

2 Click New. The first panel of the Rules Wizard appears.
3 In the list of rule types, select Check messages when they arrive, and then 

click Next.
4 In the list of rule conditions, check With Specific words in the subject box.
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5 In the Rule description box, click Specific Words. The Search Text dialog box 
appears.

6 In the Add new box, type CallPilot Notification.

7 Click Add. The text “CallPilot Notification” is added to the Search list box.

8 Click OK. The search text “CallPilot Notification” appears in the rule description.

9 Click Next.
10 In the list of actions, check the move it to the specified folder box.
11 In the Rule description box, click Specified. A list of Outlook folders appears.

12 In the folder list, choose CallPilot Notification, and then click OK. The folder 
name appears in the rule description.
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13 Click Finish. The finished rule is shown below:

14 Click OK to close the Rules Wizard.
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Configuring BlackBerry Desktop Manager

This section explains how to configure BlackBerry Desktop Manager to redirect your 
e-mail notification messages.

If you did not create a holding folder for notification messages, and if you already 
configured BlackBerry Desktop Manager to forward messages in your Outlook inbox, 
you can skip this section.

To configure e-mail redirection
1 From the Windows Start menu, choose Programs > BlackBerry > 

Desktop Manager. BlackBerry Desktop Manager appears.

2 In the application list, double-click Redirector Settings. The Redirector Settings 
dialog box appears.

3 Click the Advanced tab.

4 In the Folder redirection section, choose Selected folders.

5 Click Choose Folders… .The Choose Folders dialog box appears.

6 Select the folders where you receive messages that you want to redirect to your 
BlackBerry device.

� To redirect messages in your holding folder, select the CallPilot Notification 
folder.

� To redirect all messages in your Outlook inbox, select the Inbox folder.
7 Click Save to save your folder selection.

8 Click OK to save your redirection options.

9 Exit BlackBerry Desktop Manager. 
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Automatically removing notification messages

This section explains how to configure Outlook to remove messages automatically from 
the CallPilot Notifications holding folder using the AutoArchive feature. If you do not 
want Outlook to delete notification messages automatically, you can manually delete 
them from the folder.

You must perform two steps to configure automatic deletion of notification messages:

1 Set up AutoArchive to delete messages from the CallPilot Notifications folder.
2 Activate the AutoArchive feature.

To set up deletion of notification messages
1 In the Outlook Folder List, right-click the CallPilot Notifications folder, and then 

choose Properties. The CallPilot Notification Properties dialog box appears.

2 Click the AutoArchive tab. 

ATTENTION
If you currently do not use AutoArchive, ensure that you become 

familiar with this feature before you activate it. You can have existing 
folders with AutoArchive settings that have never been activated. If 

you activate AutoArchive to delete messages automatically from the 

CallPilot Notifications folder, you may find that messages in other 
folders are being archived as well.

If you are unsure about what to do, check with your local Microsoft 
Outlook support group.
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3 Select the Clean out items older than check box. 

4 Set the time to 1 day. 
5 Select Permanently delete old items. 

6 Click OK.

To activate AutoArchive
1 In Outlook, choose Tools > Options. 

2 Click the Other tab.
3 Click AutoArchive. The AutoArchive dialog box appears.

4 Check the AutoArchive every… box and set the frequency to 1 day.
5 Click OK to close the dialog box.

6 Click OK to close the Options dialog box. 
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